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Georeferencing and Google Earth
 Cyberinfrastructure: Specimen Databases: Day 5
 Brigette Zacharczenko
 1
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� Georeferencing standards
 � Georeferencing of legacy data
 � Georeferencing exercise
 � Mapping data
 � Using Google Earth� Using Google Earth
 � Importing data into ArcGIS
 � Google Earth exercises
 2
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Georeferencing
 � Introduction
 � Collecting Data
 � The Georeferencing Process
 � Legacy Data
 � Data Quality� Data Quality
 � Guidelines
 3
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Introduction
 � Georeference = to translate a locality description into a mappable representation of a feature
 4

Page 5
                        

Where to get data?
 � Your own research
 � Online
 � Collection databases
 � Local/state websites
 � USGS http://www.usgs.gov/
 � National Geo-spatial Intelligence Agencyhttps://www1.nga.mil/Pages/Default.aspx
 � Gazetteers
 � Maps – TopoZone http://www.topozone.com/
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Collecting Data
 � Detailed locality descriptions
 � Even if you do have coordinates!
 � Importance of redundancy
 � Think about stable vs. unstable localities
 � Could that boulder be moved? Could that big tree be cut down? Will that old barn still be there in 50 years? Will that old barn still be there in 50 years?
 � Direction, distance
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 6
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Collecting Data with a GPS
 � Using a GPS unit
 � Need an open area, and should detect at least four satellites
 � What to record
 � Coordinates
 The datum (usually WGS84)� The datum (usually WGS84)
 � Accuracy
 � Make of GPS receiver
 � Year, elevation, extent
 � Be aware of
 � True vs. Magnetic North
 7
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Collecting Data - GPS
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 8
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The Georeferencing Process
 � Creating a database� Decide which fields you need
 � What is useful to your research question
 � Think about DarwinCore standards
 � Put constraints on fields to reduce errors
 � Standards and guidelines� Units, methods for determining uncertainty and extent
 � Required fields, format of coordinates, decimal places
 � How to deal with “null” values
 � What data validation is required before a record can be considered complete?
 9
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http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 10
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http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 11

Page 12
                        

Legacy Data
 � What to do about backlog of specimen records in museums and collections?
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 12
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Legacy Data
 � Classifying locality descriptions� The most specific part of the locality description should be used
 for georeferencing
 � Determining coordinates and extents� Gazetteers
 � A gazetteer is a geographical dictionary or directory, an important reference for information about places and place names, used in conjunction with a map or a full atlasconjunction with a map or a full atlas
 � Fuzzy Gazetteer� Can handle variations in spelling, great for old labels
 � Fuzzy Gazetteer http://isodp.fh-hof.de/fuzzyg/query/� US Census Gazetteer
 http://www.census.gov/geo/www/gazetteer/gazette.html
 � USGS Gazetteerhttp://geonames.usgs.gov/domestic/download_data.htm
 13
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http://isodp.fh-hof.de/fuzzyg/query/
 14
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Determining Coordinates and Extents
 � Finding the extent
 � Every named place occupies a finite space, or ‘extent’. The extent is usually measured as the distance from the geographic center of the shape that defines the feature, to the furthest extremity of that shape.
 � Irregular shape, two choices:� Irregular shape, two choices:
 � Measure along the vector and determine the mid-point as the location
 � Determine geographic center (midpoint of extremes of lat and long), extent is the distance from that position to the furthest point. If the geographic center does not lie on the locality exactly (like a river), choose the closest point
 15
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Determining Coordinates and Extents
 � Extents – area vs. linear
 � Differentiating between an entire path you traveled, vs. measuring from the center to the perimeter of an areal extent
 � Be consistent – measure from the midpoint to the farthest point
 16
 point
 � Area could also be calculated for an irregular shape in a mapping program such as ArcMap
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Calculating Uncertainties
 � Valuable to determine data quality
 � Unknown datum
 � There can be differences from a few cm to several km
 � Distance
 � Several methods (by fraction, powers of 10)Several methods (by fraction, powers of 10)
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
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Coordinate Precision
 uncertainty=sqrt( lat_error2 + long_error2)
 lat_error = pi*R*lat_long_precision/180.0
 long_error = pi*X*lat_long_precision/180.0
 R is the radius of curvature of the meridian at the given latitude,
 X is the distance from the point to the polar axis orthogonal to the polar axis
 lat_long_precision is the precision with which the coordinates were recorded,
 as a fraction of one degree.
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
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Coordinate Precision
 � Use this table for estimation
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 19
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Maintaining Data Quality
 � Feedback to collectors – ensure consistency
 � Feedback from users – have a system for handling, verifying, and recording user feedback
 � Data checking
 � Data entry
 � New trainee – check first batch of records, and regular random checks after that
 � Data validation
 � Check against your database, other databases, gazetteers
 � Use statistical methods or modeling to determine outliers
 20
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Maintaining Data Quality
 � Always add, never replace or delete!
 � Have extra fields to make changes
 � “Remarks” fields
 � Record who made the changes
 � (Could depend on the type of change – fixing spelling vs. a new name)spelling vs. a new name)
 21
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Maintaining Data Quality� 1. Completeness Index
 � • percentage of records with georeference fields that have values
 � • percentage of records with extent fields that have values
 � • percentage of records with uncertainty fields that have values
 � • percentage of records with coordinate-precision fields with a value
 � • percentage of records with datum fields that have a known datum value
 � 2. Uncertainty Index
 � • average and standard deviation of ‘uncertainty’ value for those records that have a value
 � • percentage of records with a maximum uncertainty value in each class
 � a. <100 m
 � b. 100-1,000 m � b. 100-1,000 m
 � c. 1,000-2,000 m
 � d. 2,000-5,000 m
 � e. 5,000-10,000 m
 � f. >10,000 m
 � g. not determined
 � 3. Currency Index
 � • time since last data entry
 � • time since last validation check
 � 4. Validation Index
 � • percentage of records that have undergone validation test x
 � • percentage of records that have undergone validation test y, etc.
 � • percentage of records identified as suspect using validation tests
 � • percentage of suspect records found to be actual errors
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
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Guidelines
 � As put together by BioGeoMancer
 � http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 � Darwincore
 http://rs.tdwg.org/dwc/terms/� http://rs.tdwg.org/dwc/terms/
 23
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EXAMPLE 1
 PENNA, Indiana Co.
 3 mi NE of Elderton
 © Brigette Zacharczenko24
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EXAMPLE 1
 � What does PENNA mean? Check for unusual state abbreviations.
 http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations
 � Next we will look for Elderton.
 http://isodp.fh-hof.de/fuzzyg/query/
 http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations
 25
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EXAMPLE 1
 � So now we have:
 � Lat: 40°41'42'' N; Long: 79°20'30'' W
 � How to check that this is the right place, and to find the location 3 miles NE of the town?
 � Let's look in Google Maps
 http://isodp.fh-hof.de/fuzzyg/query/
 26
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EXAMPLE 1
 � We landed in the town of Elderton in Pennsylvania, looks good! The coordinates are usually given as the center of the town.
 http://maps.google.com/
 27
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EXAMPLE 1� Now what about the actual collection locality?
 � Open Google Earth, and search by the coordinates.
 � Using the Ruler tool, draw a path 3 miles to the NE of the town.
 � Save the line, zoom in to the end, add a point, and collect the coordinates.
 http://www.google.com/earth
 28
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EXAMPLE 1
 � Now we have 40.725466°, -79.301415°
 � But we cannot really know if that is quite where the specimen was collected. Being 3 miles northeast of the town could be a very rough estimate. So how should we treat the coordinates?
 http://www.google.com/earth
 29
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EXAMPLE 1
 � By reducing the accuracy (the number of decimal points) we can cover a wider area with our uncertainty, hopefully including the collection locality. Let's say we want to include an area of about 100m in any direction. Accuracy changes with latitude, so we would have an uncertainty of about 140 m.
 � Alternatively, we could keep the exact coordinates, and have a separate column for uncertainty. In this case, extent would not be meaningful.
 http://www.herpnet.org/herpnet/documents/biogeomancerguide.pdf
 30

Page 31
                        

EXAMPLE 1
 � So now we have:
 � Country: USA
 � State: Pennsylvania
 � County: Indiana Co.
 � Location: 3 mi NE of Elderton
 Coordinates: 40.725°, -79.301°� Coordinates: 40.725°, -79.301°
 � This information can be added to your database (do not worry about having separate columns for the later exercise, you can replace your data)
 31
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EXAMPLE 2
 � Now let’s try one from Turkey!
 TURKEY, Kirklareli Prov.,
 Dereköy, elev. 600m
 © Brigette Zacharczenko32
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EXAMPLE 2
 � Way too many results… what now?
 http://isodp.fh-hof.de/fuzzyg/query/
 33
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EXAMPLE 2
 http://maps.google.com/
 http://www.google.com/earth
 34
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EXAMPLE 2
 � So now we have:
 � Country: TURKEY
 � Province: Kirklareli
 � Town: Dereköy
 � Coordinates: 41.93°, 27.36°
 35
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GEOREFERENCING EXERCISE
 � Your specimens have varying levels of locality information on their labels. Use any available resources to find the latitude and longitude for each location, and fill in any other missing locality data. If a lat/long are provided, double check the accuracy. � Choose 6 specimens for this exercise
 � Each specimen label is like its own little detective story, there is no one correct way to verify a location. The accuracy will depend on how much information is available to you and how much you are able to interpret.
 � When you are done add this information to your database, and email it to Brigette.
 36
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Helpful Resources:
 � Google Earth
 � http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations
 � http://isodp.fh-hof.de/fuzzyg/query/
 � http://maps.google.com/� http://maps.google.com/
 � http://www.fcc.gov/mb/audio/bickel/DDDMMSS-decimal.html
 37

Page 38
                        

Visualizing Specimen Data
 � Many programs available, depending on your needs
 � Do you just want to see a distribution of points, or do more in depth analysis?
 � Do you want to have specimen data appended to the points?
 � Google Earth, Google Maps, ArcMap, Berkeley Mapper, R, Discover Life
 38
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Applications
 � Biogeography
 � Species richness
 � Species characteristics such as age class, prey/host, niche, body size, guild, clutch size, etc.
 � Patterns through time such as climate change, the � Patterns through time such as climate change, the spread of invasive species and diseases, the impact of human activities
 � Examples: http://www.yale.edu/jetz/publications.html
 39
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Google Earth
 � Visualize your data collection
 � Keep a log of your collection points, notes, and photos in one interactive file
 � Share your data with others
 � Coordinate data between Google Earth and other programsprograms
 http://www.google.com/earth
 40
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Getting Started
 � Importing data into Google Earth
 � Directly from a GPS
 � Manually, one point at a time
 � Import a spreadsheet
 � Import from ArcMap
 41
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GPS to Google Earth
 � Garmin, Magellan, Wintec WBT-201
 � More details about supported devices here
 http://www.google.com/earth
 42
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GPS to Google Earth
 � Directly from GPS, or from a file created by your GPS on your computer
 http://www.google.com/earth
 43
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Manually Adding Data Points
 � Would be tedious for an already established database
 � Fine for a few points, or if you want to visualize your progress during a trip as you go along
 44
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Quick and Easy Example
 � Don’t have time to play around with codes or making it look fancy – drop some points and photos
 http://www.google.com/earth
 45
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Quick and Easy Example
 http://www.google.com/earth
 46
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Quick and Easy Example
 � If you want to customize the pop-up information for a point, you can add code to the description to include photos, links, etc.
 http://www.google.com/earth
 47
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Tools
 � You can create:
 � Points, polygons, paths, image overlays, photos, tours
 � Paths will follow contours
 � A tour will record your
 mouse clicks – if you click
 on points, images, travelon points, images, travel
 to a new area, etc.
 � You can measure:
 � Straight lines, paths
 http://www.google.com/earth
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Importing from a Spreadsheet
 � Google docs – Spreadsheet Mapper v2.0
 � Click here for tutorialhttp://earth.google.com/outreach/tutorial_spreadsheet.html
 � To get started: starter spreadsheethttp://spreadsheets.google.com/ccc?key=p-zIWuNNsnGKqQ_V-SpUsRQ&newcopyzIWuNNsnGKqQ_V-SpUsRQ&newcopy
 � Can handle up to 400 placemarks
 � Spreadsheet Mapper has templates to visualize your information in Google Earth, you can edit them or create your own
 49
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Spreadsheet Mapper v2.0
 https://spreadsheets.google.com
 50
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Spreadsheet to Google Earth
 http://www.google.com/earth
 51
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http://www.google.com/earth
 52
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Importing from a Database
 � Can be tricky, depending on the database!
 � Some have direct links to show points in Google Earth
 � If you can obtain an Excel file of data, you can use Google Fusion http://www.google.com/fusiontables to create a KML file to create a KML file
 � Unlike the Spreadsheet Mapper, Google Fusion can handle over 400 placemarks
 53
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Collecting data from HerpNET
 http://www.herpnet.org/54
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Collecting data from HerpNET
 � Open the file in Notepad
 � Save as a .txt file
 � New file in Excel > Data tab > From file > Choose your .txt file
 � Data clean-up: You MUST remove all records � Data clean-up: You MUST remove all records missing coordinates. The data table will not omit them, it will instead create a map based on the country or state.
 � Change the “decimalLatitude” to “Latitude” and “decimalLongitude” to “Longitude”
 55
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Google Fusion Tables
 � New table > Import table > Choose your Excel file
 � You can edit the table here
 http://www.google.com/fusiontables
 56

Page 57
                        

Google Fusion to Google Earth
 � Visualize > Map > Export to KML > Save file
 http://www.google.com/fusiontables
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It’s like magic!
 � Google Earth
 � File > Open
 http://www.google.com/earth
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Sharing
 � To save a folder� Make sure the folder you want to save is highlighted
 � File > Save > Save place as > Save as .kmz
 � To double check, you can try opening the file in Google Earth
 http://www.google.com/earth
 59
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Sharing
 � To save a snapshot image of exactly what is on your screen
 � File > Save > Save image > Save as .jpg
 To share your file� To share your file
 � Simply email them the file you have saved!
 � Sharing with the Google Earth Community
 � You need to be a member
 60
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Google Earth Layers
 � Regular users have access to:
 � Panoramio (user images), Roads, Weather, Terrain, Street View, Ground Level View, 3D trees (version 6 and later)
 � Pro users have access to:� Pro users have access to:
 � Demographics, Parcel Boundaries, Traffic Count
 61
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Google Earth Pro
 � “Increase employee productivity, communicate visually, and share geographic information with Google Earth Pro. With the same easy-to-use features and imagery of Google Earth and additional capabilities designed specifically for business users, Google Earth Pro offers the most comprehensive geospatial database, including seamless cityscapes, high-resolution imagery, historical seamless cityscapes, high-resolution imagery, historical imagery, roads, and points of interest.”
 � “Expand your business, explore untapped markets and understand your target demographic using Google Earth Pro Datasets. View parcel, demographic, and daily traffic count data for the US overlaid on top of the same, familiar imagery of Google Earth.”
 62
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Google Earth Pro
 http://www.google.com/earth
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Google Earth Enterprise
 � “Google Earth Enterprise allows you to create 2D browser based maps similar to Google Maps in addition to custom globes similar to Google Earth. Mashup terabytes of imagery and terrain data with to your POI, road data and live data streams. Let novices feel like GIS experts with accessible GIS novices feel like GIS experts with accessible GIS data.”
 � Useful for very large datasets
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The Future of Google Earth
 � What’s on the horizon?
 � Adding more GIS layers?
 � More high res images?
 � More tools for biologists?
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http://www.google.com/earth
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http://www.google.com/earth
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http://www.google.com/earth
 68

Page 69
                        

To Learn More:
 � Google Earth Homehttp://www.google.com/earth/index.html
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Google Earth and GIS
 � Since Google Earth does not currently have all the tools a biologist needs, it can be used in conjunction with ArcGIS
 � If your data starts in ArcMap� You might want to share your results in an intuitive way to
 non-scientistsnon-scientists
 � You might want to share your results with other scientists without divulging your original files
 � If your data starts in Google Earth� You might want to investigate ecological questions by
 overlaying parameters such as soil type, vegetation, human habitation, precipitation, monthly temperatures, other species ranges, etc.
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Google Earth and GIS
 � Data exploration
 � You never know what will inspire you to ask new questions
 � Visualizing your data in Google Earth could reveal new features not available in old shapefiles (new roads, forests that have been cut, sea levels changing)forests that have been cut, sea levels changing)
 � Keep in mind
 � Google Earth uses the datum WGS84
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Google Earth to ArcMap
 � You need to download a new toolbox: Convert KML to SHP
 � Save your Google Earth file as .kml
 � Use the toolbox to create a shapefile
 72
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Google Earth to ArcMap
 http://www.google.com/earth
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ArcMap to Google Earth
 � Conversion Tools > To KML > Layer to KML
 � Open the resulting file in Google Earth
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GOOGLE EARTH EXERCISE 1
 � Use Google Spreadsheet Mapper v2.0 to map your specimen data in Google Earth� Make sure your Excel file only includes records with
 coordinates
 � Follow this Tutorialhttp://earth.google.com/outreach/tutorial_spreadsheet.html
 � Choose at least one specimen to include a photo and full � Choose at least one specimen to include a photo and full collection data
 � For adding Flickr images:
 � Go to image page, right click, choose “View All Sizes: Medium 500”. Right click, choose “Copy Image Location”
 � Save the Google Earth file and email it to Brigette
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Troubleshooting� Be sure you follow the tutorial instructions carefully
 � Sometimes there are issues copying and pasting within the spreadsheet – be patient, but persistent!
 � The template number should be used in the first header row, as well as the data rows
 � The information in each column should match the header label, based on the template number
 When copying the network link to
 76
 � When copying the network link to
 Google Earth – click on the cell, use
 “ctrl+c”, then right click “My Places”
 in Google Earth, there should be an
 option to “Paste”
 � If you cannot get the spreadsheet to connect to Google Earth, try the link to see it in Google Maps. You can still look at your data points and photos this way.
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GOOGLE EARTH EXERCISE 2
 � Collect specimen records from HerpNET and map them in Google Earth using Google Fusion Tables� Choose any species, gather as many records from as
 many institutions as you would like
 � In Excel, create a file that only has records with coordinates
 Open the file in Google Fusion, and create a KML file� Open the file in Google Fusion, and create a KML file
 � Open the KML file in Google Earth
 � Follow the step-by-step instructions as given in the example on slides 53-58
 � Save the Google Earth file and email it to Brigette
 77
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